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WELCOME TO RAPID SQL

Rapid SQL is an integrated cross-platform database development environment that provides a

highly-intuitive and well-integrated interface. Its graphical facilities simplify SQL scripting, object
management, reverse-engineering, database project management, version control, and schema
deployment. Additionally, it provides comprehensive tools for tuning and editing code to ensure

high-performance and quality.

Rapid SQL offers support for all major databases including IBM DB2, InterBase/Firebird,
Microsoft SQL Server, MySQL, Oracle, and Sybase.

The table below describes the major sections of Help.

Section

Description

Getting Started

Provides an introduction for new users and helps you set up Rapid SQL. Included is an
investigation of the major user interface elements, detailed tutorial exercises, and
instructions on configuring Rapid SQL features.

Datasource
Management

Shows you how to register the datasources that Rapid SQL will work against.This chapter
also describes the extensive datasource management facilities.

Database Object
Management

Describes how to create new database objects, edit existing objects, and provides
details on the operations you can perform against database objects.

SQL Scripting Describes the development/execution/testing environments offered.
Tools Tools provide search, script and file execution, scheduling, visual difference, a visual

query builder, data import, a DML generation facility, a data editor, and an auto-replace
tool for the scripting environment.

Project Management

Rapid SQL provides project support and version control system integration.

Rapid SOL Add-On
Tools

License-dependent add-ons include:

Debuggers - Rapid SQL provides debugging environments for DB2 LUW, SQL Server,
Oracle, and Sybase.

Oracle PL/SQL Profiler - captures metrics of various PL/SQL programmable objects as
they are executed

Code Analyst - helps you identify time-consuming lines of code.

ADDITIONAL PRODUCT RESOURCES

The Embarcadero Web site is an excellent source for product information and access to

additional resources:

e Release notes and product documentation

¢ Information on other Embarcadero application and database development tools

e Embarcadero Development Network

e Product and technical support

RAPID SQL XE 2/8.0.1 USER GUIDE 11
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e Educational and product expertise material in the form of online demos, white papers, and
video presentations

e Access to sales staff and Embarcadero resellers

For access, direct your browser to www.embarcadero.com.

PREREQUISITES AND PRELIMINARY TASKS

The following topics provide information on requirements that must be satisfied and initial setup
tasks that must be performed before using Rapid SQL:

® Technical Requirements

e Database Support

® Licensing

TECHNICAL REQUIREMENTS

Rapid SQL is a 32-bit application that runs in a Microsoft Windows environment. Before using
Rapid SQL, please verify that your environment meets the following requirements:

e Hardware requirements

¢ Operating system requirements

NOTE: Users need full registry privileges during the installation and access to the keys under
HKEY_CURRENT_USER in the registry after installation.

HARDWARE REQUIREMENTS
Embarcadero Technologies recommends the following minimum hardware requirements:

e 1024 MB of memory
® 512 MB of disk space

OPERATING SYSTEM REQUIREMENTS
Rapid SQL supports the following operating systems:

* \Windows XP (32-bit and 64-bit)
¢ \Windows Vista (32-bit and 64-bit)
¢ Windows 7 (32-bit and 64-bit)
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For more detailed information, see the following topics:

e XP Support

e Vista and Windows 7 Support

e 32-bit Versus 64-bit Operating System Support and Restrictions

XP SUPPORT
Windows XP has two user security groups:

e Users
e Power Users

Microsoft intentionally does not grant members of the Users Group the authority to install
applications or make global changes to the system. Restricted Users are members of the Users
Group. Standard users belong to the Power Users Group. Microsoft grants members of the
Power Users Group the authority to install programs. You must be a member of the
Administrators Group in order to install and use Embarcadero Technologies applications.

Because Restricted Users are members of the Users Group, they cannot install and run
Embarcadero Technologies applications.

CAUTION: You must be a member of the Administrators Group in order to install and use
Embarcadero Technologies applications.

To open the Group Membership tab where you can determine your group and review the
Microsoft security guidelines:

1 On the Control Panel, open User Accounts.
2 On the Users tab, select a user and then click the Properties button.

3 Click the Group Membership tab.

VISTA AND WINDOWS 7 SUPPORT
Windows Vista UAC and Windows 7 provide two user types:

e Standard user
e Administrator

Rapid SQL can be installed or uninstalled by an administrator or by a standard user using an
administrator token. Standard users can run Rapid SQL.

CAUTION: For the purposes of running Rapid SQL, default standard user token privileges
should not be modified. Modifying standard user token privileges can result in
licensing issues which will prevent Rapid SQL from operating properly.
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32-BIT VERSUS 64-BIT OPERATING SYSTEM SUPPORT AND RESTRICTIONS

Rapid SQL is a 32-bit application that runs emulated on 64-bit versions of Windows. The only
requirement is that Rapid SQL supports only 32-bit versions of the client software that must be
installed for connectivity to each DBMS that Rapid SQL will work against.

DATABASE SUPPORT
The table below describes the database platforms Rapid SQL supports and the server and client

requirements:

Platform

Server

Client

IBM DB2 for z/OS

IBM DB2 for z/OS 8 and 9

When going through a DB2 Connect
gateway, DB2 Client for Windows 6.0 or
later. When going directly to the mainframe
from the client, DB2 Connect Personal
Edition vé or higher on the client machine.

IBM DB2 for Linux, Unix,
and Windows

IBM DB2 Universal Database 8.0 - 9.7

IBM DB2 Client for Windows 7.2 or later.

NOTE: When using a v8 client, Rapid SQL
only supports connecting to a v8 Database
on Windows, Linux and Unix.

InterBase/Firebird

InterBase 2007 and InterBase 2009

DataDirect ODBC driver for InterBase and
the InterBase Client

Firebird 2.0

Firebird ODBC Driver

Microsoft SQL Server

Microsoft SQL Server 2000, 2005, and 2008

NOTE: For SQL Server 2005 and 2008, only
object types like users, logins, roles, config
parameters, etc., are supported. We do
NOT support Microsoft .NET extensions at
this time.

Microsoft SQL Server Client Library

MySQL MySQL 4.x. (Rapid SQL is tolerant of 5.x MySQL ODBC driver 3.5.1 and above
but does not support Stored Procedures,
Triggers, Views.)
Oracle Oracle 8i, 9i, 10g, and 11g Oracle SOL*Net Client
Sybase ASE Sybase ASE 12.5-15.0.3 Sybase Open Client
NOTE: Since Rapid SQL is a 32-bit application that runs emulated on é4-bit versions of

Windows, only 32-bit versions of the DBMS client software are supported.

IBM DB2 FOR Z/OS STORED PROCEDURE REQUIREMENTS

When working against an IBM DB2 for z/OS data source, Rapid SQL relies on the following
stored procedures, provided as an optional installation step in setting up the DB2 subsystem:

e DSNWZP

e DSNUTILS

14
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e ADMIN COMMAND DSN
e ADMIN_ COMMAND DB2

Prior to using Rapid SQL against an IBM DB2 for z/OS data source, ensure that these
components are installed on the server. See http://publib.boulder.ibm.com/infocenter/dzichelp/

v2r2/topic/com.ibm.db2.doc.inst/stpadd.htmi#stpadd for more information.

LICENSING

Each Embarcadero client application requires one or more licenses in order to run. An
Embarcadero product, such as Rapid SQL or ER/Studio, has a baseline license which provides
basic feature support for that product. In addition, incremental licenses may be required to
support specific DBMS platforms, product add-ons, or other functions.

For more information, see the following topics:

e |icensing Overview

e Licensing your Application

e Selecting a License Cateory During Startup

e Online/Offline Mode and Concurrent License Checkout

LICENSING OVERVIEW

The following topics provide a high-level discussion of key licensing topics and directs you to
sources of more detailed information.

e \iewing your License Type and Modules

Understanding Trial, Workstation, and Networked Licenses

Rapid SQL License Modules, DBMS Support, and Feature Availability
Rapid SQL XE License Modules, DBMS Support, and Feature Availability

Directing Queries Regarding Licenses

VIEWING YOUR LICENSE TYPE AND MODULES

The About... dialog, available from the Help menu, displays your license type and each
individual license module currently registered.
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UNDERSTANDING TRIAL, WORKSTATION, AND NETWORKED LICENSES
Three kinds of licenses are available: Trial, Workstation, and Networked.

Trial licenses A license for a 14-day, full-featured trial version of the product. The trial license must be
registered before you can use the product.

Workstation licensing A license or set of licenses is tied to a particular workstation. The product can only be
used on that workstation.

Networked licensing Networked licenses are administered and distributed by a central License Server
(Embarcadero License Center or Acresso FLEXnet Publisher). There are two types of
networked licenses: Concurrent and Networked Named User. With Concurrent licensing,
users on different machines take turns using licenses from a shared pool. With
Networked Named User licensing, licenses are pre-assigned to specific users setup on
the license server's user list. Those users are guaranteed to have licenses available any
time.

NOTE: Concurrent licenses can be borrowed for use without a network connection. For
details, see Online/Offline Mode and Concurrent License Checkout.

For a detailed description of licensing options, see http://www.embarcadero.com/software-
licensing-solutions.

RAPID SQL LICENSE MODULES, DBMS SUPPORT, AND FEATURE AVAILABILITY

Individual license modules correspond to the DBMS platforms you are licensed to use. In
addition, each DBMS license module corresponds to a product edition. Feature availability for
each license module edition is as follows:

e Standard - Provides baseline support including datasource management, object
management, SQL editing and execution, and standard tools and utilities.

® Professional - Standard edition features plus SQL Debugger, SQL Profiler, and Code
Analyst.

RapID SQL XE LICENSE MODULES, DBMS SUPPORT, AND FEATURE AVAILABILITY

An XE license provides access to all supported DBMS platforms. XE module and feature
availability is as follows:

¢ XE Pro - Provides baseline support including datasource management, object
management, SQL editing and execution, and standard tools and utilities, SQL Debugger,
SQL Profiler, and Code Analyst.

DIRECTING QUERIES REGARDING LICENSES

Questions regarding license availability, feature availability, and client or server licensing, should
be directed as follows:

e If you work in an organization that uses networked licensing, direct any questions to your
site’s Rapid SQL administrator.

16 RAPID SQL XE 2/8.0.1 USER GUIDE
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e |f you are using workstation licensing, direct licensing questions to your Embarcadero
Technologies representative.

LICENSING YOUR APPLICATION
See the following topics for details on registering your product:

e Registering a trial or workstation license during installation

® Registering a workstation license after application startup

® Registering by phone

e Registering a networked license

REGISTERING A TRIAL OR WORKSTATION LICENSE DURING INSTALLATION

Shortly after initiating download of a trial version of an Embarcadero product, you should receive
an email with a serial number you must register during installation. Similarly, if you purchase an
Embarcadero product while no trial version is active, you will receive a serial number that must
be registered during installation.

1 Start the installation. An Embarcadero License Registration dialog appears.
2 Copy the serial number from the email and paste it in the Serial Number field.

3 Enter your Embarcadero Developer Network account credentials in the Login or Email and
Password fields. If you have not previously created an EDN account, or have forgotten your
password, click | need to create ... or I've lost my password.

4 Click Register.

Your activation file should be downloaded and installed automatically. If this does not happen,
click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still
have problems, see Registering by phone.

REGISTERING A WORKSTATION LICENSE AFTER APPLICATION STARTUP

The following instructions assume that you have received a workstation license by email and that
you currently have a valid trial license. If you did not install a trial version or the trial period has
expired, follow the instructions in Registering a Trial or Workstation License During Installation
instead.

1 On the Help menu select About and then on the dialog that opens, click Manage to open a
license manager dialog.

2 On the Serial menu, select Add.

3 Copy the serial number from the email and paste it in the Add Serial Number dialog, then
click OK.
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4 Right-click on the serial number you added, and then select Register from the context
menu. A registration dialog opens.

NOTE: The Registration Code box shows a machine-specific identifier required with other
registration methods.

5 Ensure that the Register using Online Registration radio box is selected.

6 Provide Developer Network credentials in the DN Login name or Email and DN Password
boxes. If you have not previously created an EDN account, or have forgotten your password,
click I need to create ... or I've lost my password.

7 Click Register.
8 If prompted to restart the application, click Yes.

Your activation file should be downloaded and installed automatically. If this does not happen,
click the Trouble Connecting? Try Web Registration link and follow the prompts. If you still
have problems, see Registering by phone.

REGISTERING BY PHONE
If you have problems with either of the above procedures, you can register licenses by phone.
You will have to provide:

e Developer Network credentials

¢ The registration code displayed in the Embarcadero License Registration dialog that
appears when you start an unlicensed application

The product base license serial number

The license serial numbers for any additional features you have purchased.

For North America, Latin America and Asia Pacific, call (415) 834-3131 option 2 and then follow
the prompts. The hours are Monday to Friday, 6:00 A.M. to 6:00 PM. Pacific time.

For Europe, Africa and the Middle East, call +44 (0)1628-684 494. The hours are Monday to
Friday, 2 A.M. to 5:30 PM. U.K. time.

Shortly after phoning in, you will receive an email containing an activation file. Then do the
following:

1 Save the file to the desktop or a scratch directory such as c:\temp.

2 On the Help menu select About and then on the dialog that opens, click Register. A
registration dialog opens.

3 Select the | have received an activation file (*.slip or reg*.txt) radio box.

4 Click the Browse button and use the Select License Activation File dialog to locate and
select the activation file you installed.

5 Click the Import button to import the activation file and when complete, click the Finish
button.
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6 If prompted to restart the application, click Yes.

REGISTERING A NETWORKED LICENSE
If you work in an organization using Networked licensing, an administrator, department head, or
someone providing a similar function will provide you with an activation file.

Once you receive the file, save it to the 1icense subfolder of your product’s main installation
folder (typically C:\Program Files\Embarcadero\<product><versions>\license\),
then restart the application.

No additional steps are necessary.

SELECTING A LICENSE CATEGORY DURING STARTUP

During Rapid SQL startup, if multiple concurrent license categories are available, you are
prompted to select a category to use for this Rapid SQL session. Multiple license categories can
be set up to provide differing feature access or access to different DBMS versions. Feature and
DBMS version access are typically distributed across multiple license categories to optimize use
of a site’s purchased licenses.

NOTE: This dialog also includes the option to remember your selection on subsequent
startups. If you select that option, you can subsequently use the Select Licenses button
on the About... dialog (Help > About) to select a different license.

Contact your License Administrator for details on individual license categories or requests for
additional feature or DBMS support.

ONLINE/OFFLINE MODE AND CONCURRENT LICENSE CHECKOUT

Concurrent licenses can be used in both online and offline modes. In online mode, you must
have a continuous network connection to your License Center. Licenses are checked out when
you start Rapid SQL and checked back in when you shut Rapid SQL down.

You can also use a license in offline mode. When you explicitly check out a license for offline use,
you can use Rapid SQL without a connection to your License Center for a specified duration.
This lets you work while travelling or commuting, work away from your primary work area, or use
Rapid SQL when a network connection is unavailable or not required.

NOTE: Contact your site administrator for information on offline license availability, the
maximum duration, offline license policy at your site, or any other issues arising from
online license usage.

To check out a license for offline use:

1 On the Help menu, select Checkout License. The Check Out Licenses For Offline Use
dialog opens.

2 Select the check box associated with each individual license you want to check out.
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3 Inthe Checkout Duration box, type the number of hours that you can use the offline license
without a network connection to the License Center.

4 Click OK.
You can work offline for the specified duration. The duration period begins immediately.

If you subsequently establish a network connection to the License Center before the license
duration expires, you can indicate to the License Center that the offline license is no longer
required.

To indicate that an offline license is no longer required:
1 On the Help menu, select Checkin License.

There is no interruption in Rapid SQL usage. The license is not actually checked in until you shut
down Rapid SQL.

MORE INFORMATION ON USING THIS DOCUMENT

The following topics provide additional information that is useful when working with product
documentation:

® Accessing third party documentation

® Shorthand for third party product references

ACCESSING THIRD PARTY DOCUMENTATION

Many Rapid SQL features provide support for functionality available in the supported third party
DBMS platforms. In object management for example, properties available when creating or
editing objects and actions available against object types, are direct equivalents of clauses,
options, or keywords available for use with the third party equivalent.

In such cases, no attempt is made to duplicate detailed documentation by third parties. Casual
descriptions are provided, noting the third party equivalent. You can consult the third party
documentation for details or clarifications. The following links provide access to online
documentation for DBMS platforms supported by Rapid SQL:

IBM DB2 for Linux, Unix, and Windows documentation

IBM DB2 for z/OS documentation

InterBase/Firebird documentation

Microsoft SOL Server documentation

MySQL documentation
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¢ Oracle documentation

® Sybase documentation

SHORTHAND FOR THIRD PARTY PRODUCT REFERENCES

To save space in headings and table columns, shorthand is used to represent versions and
variations of the DBMS platforms supported by Rapid SQL.

DB2 LUW
DB2 ZOS
[TB/FBD

l® ° |® |® |l®
o K
A (2]
Sa's)
=

DB2 LUW
DB2 LUWis used as shorthand for IBM DB2 for Linux, Unix, and Windows.

DB2 z/0OS
DB2 z/OS is used as shorthand for IBM DB2 for z/OS.

ITB/FBD
ITB/FBD is used as shorthand for InterBase/Firebird.

MySQL
MySQL is used as shorthand for the MySQL RDBMS.

ORCL
ORCL is used as shorthand for Oracle.
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SQL SVR
SQL SVR is used as shorthand for Microsoft SQL Server.

SYB
SYB is used as shorthand for Sybase ASE.
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GETTING STARTED

The following sets of topics are intended for new users. They provide learning curve material and
tell you how to configure Rapid SQL:

Application Basics Introduces the major user interface elements.

Rapid SQOL Tutorial Provides detailed tutorial exercises that introduce the basic
areas of Rapid SQL functionality.

Specifying Rapid SQL application and feature options  Tells you how to configure Rapid SQL.
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APPLICATION BASICS

Application Basics is designed to situate you within the application and to provide information
about what Rapid SQL offers in the way of design, navigation, and application features. The
information presented here is high-level and conceptual.

Application Basics is divided into two sections, the table below describes each section:

Section Description

Product Design This section describes the Rapid SQL user interface.
Specifying Rapid SQL This section describes how to customize Rapid SQL’s
application and feature configuration to suit your specific needs.

options

PRODUCT DESIGN

The Rapid SQL window opens with the Database Explorer on the left, the Workspace on the
right, and all toolbars docked at the top of the application. The Output Window is not
automatically displayed. Rapid SQL also offers you a number of desktops, or workspaces, that
you can toggle among while you work.

DATABASE EXPLORER

Rapid SQL organizes the wealth of information pertaining to your servers through its Database
Explorer. The Database Explorer provides a fast and efficient way to access your database
objects and scripts. The Database Explorer is a separate window containing a tree object that
you can select and expand. The tree object organizes and nests subjects as branches. By
expanding or collapsing the tree, you can efficiently browse multiple datasources. The Database
Explorer window is dockable so that you can maneuver through the application efficiently.

The Database Explorer includes three tabs:

Explorer

Favorites

Project
VC Files

EXPLORER TAB

The Explorer Tab provides a visual method for browsing, accessing and manipulating your
database objects. The Explorer Tab lets you:

e Connect, disconnect, and browse the objects in the supported datasources on your
network.
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¢ Drag objects to the Rapid SQL workspace.
e Create new objects.

NOTE: You can assign datasources to defined categories such as production or development.
This lets you color-code and label Datasource Explorer user interface elements
associated with the datasource. For details, see Categorizing datasources using color-
coding and labelling.

Datasource Node

When you click the datasource node of the Explorer Tab tree, Rapid SQL lists all the databases
available for that datasource. When you click a database node, you can view all the database
object types available for that datasource. When expand an object type node, Rapid SQL
displays available objects. You can collapse any portion of a datasource to concentrate on a
particular portion of your database.

For more information, see:

Organizing the Explorer

Creating New Objects from the Explorer

Extracting DDL from the Explorer

Displaying Dependencies from the Explorer Tab

ORGANIZING THE EXPLORER
Rapid SQL contains functionality that lets you configure how objects are organized in the
Explorer Tab. The table below explains the available options:

Functionality Description

Organize by Object Type Select to display objects by object type for all users in the same
list. This display mode cuts performance in databases that
contain many objects.

Organize by Owner Select to display objects by owner. Most efficient if you are
working with databases containing a high number of objects.

Show Only My Objects Select to display the objects you own in the Explorer Tab.
Available if you are organizing the Explorer Tab by object type.

Show System Objects Select to display system objects.

Full Refresh Select to refresh.

Expand All Groups Select to expand all groups.

Collapse Select to collapse all datasources or collapse all groups.

Retain Group View Settings | Select to retain the current state of the Explorer Tab so that the
it opens the same way the next time you start Rapid SQL.

TIP:  You can also set these options on the Explorer tab of the Options Editor. For details,
see Explorer Options.
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Organizing the Explorer by Object Owner
1 On the Explorer Tab, click the Explorer list above the list of datasource groups.

2 Click Organize by Owner.

Rapid SQL dynamically reorganizes the display of the Explorer Tab, sorting database objects
by object owner.

Organizing the Explorer by Object Type
To organize the Explorer by Object Type, do the following:

1 On the Explorer Tab, click the Explorer list above the list of datasource groups.
2 Click Organize by Object Type.

Rapid SQL dynamically reorganizes the display of the Explorer Tab, sorting database objects
by type.

Showing or Hiding System Objects

To show or hide system objects, do the following:
1 On the Explorer Tab, click the Explorer list above the list of datasource groups.
2 Click Show System Objects to show all system objects.

3 Click the Show System Objects again to hide all system objects.

CREATING NEW OBJECTS FROM THE EXPLORER
Rapid SQL lets you create new database objects from the Explorer Tab. When you create an
object from the Explorer Tab, Rapid SQL does the following:

e Automatically brings up the Object Attachment Facility which associates the new object with
an object type.

e Opens a DDL Editor containing a shell script based on the object type you select.

e Automatically ties that object to the current database.

Creating a New Object from the Explorer

To create a new object from the Explorer, do the following:

1 In the Explorer Tab, right-click the object type node for the object to create and then click
New to open the wizard associated with that object.

The Object Type Information dialog box displays. The object type and owner are
automatically assigned based on the object type you selected in the previous step.

2 Enter the name of the object.
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3 Click OK.

Rapid SQL opens an editor containing a template for the object type.

EXTRACTING DDL FROM THE EXPLORER

Rapid SQL's Explorer Tab provides a quick, convenient method for extracting object DDL. Rapid
SQL lets you extract the DDL for multiple or individual database objects. SQL scripts are the text
of statements that are used to create database objects. Rapid SQL also lets you run SQL scripts
against other databases to recreate the database objects. You can also extract scripts to create a
record of how an object was created. Rapid SQL lets you extract the CREATE statements for any
object into a DDL Editor. If you are extracting the DDL of an Oracle procedural logic object, an
SQL Editor automatically opens instead, saving you the trouble of inserting PL/SQL tags.

Rapid SQL offers two ways to extract DDL from the Explorer Tab:

Using the Shortcut Menu

1 Select one or more objects in the Explorer Tab. To select contiguous objects, hold SHIFT
and select multiple objects. To select noncontiguous objects, hold ALT and select specific
objects.

2 Right-click to display the shortcut menu and then click Extract.

Dragging Objects

1 Select one or more objects in the Explorer Tab. To select contiguous objects, hold SHIFT
and select multiple objects. To select non-contiguous objects, hold ALT and select specific
objects.

2 Drag the script(s) to the desired position in the Rapid SQL workspace.

DISPLAYING DEPENDENCIES FROM THE EXPLORER TAB
Rapid SQL lets you open a result set window, directly from the Explorer Tab, to display
dependencies for an object.

Displaying Dependencies from the Explorer Tab
1 On the Explorer Tab, double-click the object node.

Rapid SQL displays the list of objects.
2 Right-click the target object and then click Dependencies.
Rapid SQL opens the Dependencies window which lists all dependent objects.

NOTE: Rapid SQL does not retrieve dependencies if objects are created out of order.

28 RAPID SQL XE 2/8.0.1 USER GUIDE



APPLICATION BASICS

FILTERING IN THE EXPLORER
For ease of navigation, Rapid SQL lets you filter the Explorer tree to display only selected nodes
and objects. Rapid SQL offers the following filtering options:

® Real-time modification of the tree to show only nodes with names matching a typed
character string. For details, see Simple, on-the-fly, character-based tree filtering.

e Permanent object filters, enabled and disabled for individual data sources, that restrict
display based on object name and owning schema (and optionally, object type). For details,
see Object Name/schema Filtering.

® The ability to restrict object types displayed for each DBMS platform. For details, see Node
or Object Type, Filtering.

Two default filters applying to owned and system objects are available. For details, see Using the
Default Filters. Default and custom filters are available in the Explorer tree Filters node for each
data source. For details, see Filters Node.

SIMPLE, ON-THE-FLY, CHARACTER-BASED TREE FILTERING
The Filter box at the top of the Explorer provides a quick, ad hoc way to restrict the nodes
displayed.

I x4

To restrict the Explorer tree display to only user-defined nodes whose name contains a
particular character string

e Type one or more characters in the Filter box.

The display is updated to show only nodes whose name contains the typed character string and
their parent nodes.

NOTE: The Clear button in the Filter box (X) deletes the contents of the Filter box and restores
the unfiltered tree display.

OBJECT NAME/SCHEMA FILTERING

Object filters let you restrict Explorer tree display for a data source by name, owning schema, or
name/schema combinations. These filters are defined at the DBMS platform level and enabled
or disabled on a data source by data source level. Multiple object filters can be created for a
DBMS platform, letting you enable combinations of filters for a single data source, ad hoc
enabling and disabling of individual filters depending on your requirements, and so on.

Each filter consists of one or more ANDed conditions based on name or schema. For example
you could create a two-condition filter that restricts the Explorer tree for a data source to display
only objects belonging to the Schema QA and whose name starts with the string Test.
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Each filter condition is a simple expression that tests object names for equality (Equals, Not
Equals), inclusion in a specified list (In, Not In), or using pattern matching (Like, Not Like).
Optionally, an object filter can also be used to restrict display of specified object types on a data
source.

To create an object filter that can be enabled for all data sources for a DBMS platform

1

30

Right-click in the left pane of the Datasource Explorer tree and select Filter from the context
menu. The Filters dialog opens.

In the View area, select By Filter.

NOTE: The current instructions create a filter at the DBMS level. To create a filter for a single
data source, select the By Datasource view, select a specific data source, and then
proceed to step 4.

Expand the icon corresponding to the DBMS for which you want to create a filter and ensure
that the icon is selected.

Click New and type a name for the new filter.
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5 On the Predicates tab, create one or more name-based or schema-based conditions, all of
which must be satisfied when this filter is enabled. Objects that do not satisfy the conditions
will be filtered from view. Use the following guidelines in constructing conditions:

¢ The Like and Not Like operators take pattern-matching Values. Use any pattern matching
characters and conventions supported by the DBMS for which you are defining the filter.

e The In and Not In operators take a comma-delimited list such as CO,CA,CU, as a Value.
e Click the associated New button to add new predicates.

6 Optionally, on the Database Elements tab, select the check boxes for all object types to
which this filter is to be applied. The filter does not affect the display of any deselected
object types.

7 Click OK.

By default, when you create an object filter for a DBMS platform, it is enabled for each
registered data source of that DBMS type.

To disable or enable an object filter for a data source

1 Right-click in the left pane of the Explorer tree and select Filter from the context menu. The
Filters dialog opens.

2 Inthe View area, select By Datasource.

3 Expand the icon corresponding to the target DBMS and then expand the icon
corresponding to the specific data source for which you want to for enable or disable a filter.

4 Enable an object filter by selecting the associated check box or disable the object filter by
deselecting the check box.

5 Click OK.

NOTE: You can also enable and disable filters using controls found under the Filters node for
each data source in the Explorer tree.

You can also use the Filters dialog to select and edit an object filter, rename or create a clone of
an existing object filter, and delete filters.

NODE, OR OBJECT TYPE, FILTERING

Node filtering lets you hide specified Datasource Explorer tree nodes for a DBMS platform. For
example, if you do not typically work with credential-related objects such as users or logins, you
may wish to filter those out of the Datasource explorer tree.

To change the hidden/displayed status of object types for a DBMS platform

1 Right-click in empty space in the left pane of the Explorer tree and select Filter from the
context menu. The Filters dialog opens.

2 Click the Node Filters tab.
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3 Expand the icon corresponding to the DBMS for which you want to create a node filter, and
continue to expand nodes until all nodes for which you want to change the hidden/
displayed status, are visible.

4 Ensure that all nodes corresponding to objects types that are to be displayed, are selected.
Similarly, ensure that all nodes corresponding to objects types that are to be hidden, are
deselected.

5 Click OK.

Hidden/displayed status is retained for the DBMS until you explicitly open the Filters dialog and
change the current settings.

USING THE DEFAULT FILTERS

The Filters node for each registered data source includes two default Explorer tree filters,
Ignore System Objects and Show Only My Objects. These filters can be enabled and disabled
for each data source but cannot be edited or deleted.

FILTERS NODE

The Filters node contains default Explorer tree filters and any custom filters you crete for that
data source or create across that DBMS type. Controls let you enable or disable the default and
custom filters. Options for creating and maintaining cusom filters are provided. For details, see
Filtering in the Explorer.

FAVORITES TAB

Rapid SQL provides the Favorites Tab for designating and accessing favorite scripts. On the
Favorite Scripts Tab you can do the following with frequently used SQL scripts:

* View
¢ Navigate

* Save

Recall
e Execute

TIP:  Sample Favorite Scripts are installed for Microsoft SQL Server, Oracle, and Sybase
Adaptive Server.

For more information, see Favorite Properties Dialog Box.
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FAVORITE PROPERTIES DIALOG BOX
The table below describes the options and functionality on the Favorite Properties dialog box:

Option Description

Description Lets you enter a description.

File Name Lets you type or browse and locate a file.
Hot Key Lets you enter a Hot Key.

Hot Keys must begin with CTRL or be stand-alone function
keys. Rapid SQL automatically places the CTRL command in
front of any character.

File Type Lets you select a file type.

SUBSYSTEM NODE
NOTE: The Subsystem node is available for IBM DB2 LUW for OS/390 and z/OS only.

The Subsystem node displays detailed information about the DB2 subsystem. Subsystem
objects include:

Connections

DDE

Parameters

CONNECTIONS
Connections displays the current connections to the subsystem.

NOTE: The information is read-only.

For more information, see Subsystem Node.

DDF

DDF (distributed data facility) displays the information regarding the status and configuration of
the DDF, a set of DB2 LUW for OS/390 components through which DB2 LUW for OS/390
communicates with another RDBMS.

NOTE: The information is read-only.

For more information, see Subsystem Node.

PARAMETERS
Parameters displays the DB2 subsystem parameters.

NOTE: The information is read-only.

For more information, see Subsystem Node.
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PROJECT TAB

The Project Tab provides a visual method for browsing, accessing, and manipulating your
projects. The Project Tab lets you:

® Open, close, modify, and browse projects.
¢ Drag project items to the Rapid SQL workspace.
¢ Create new projects.

NOTE: The Project Tab is available after you create or open a project.

For more information on working with projects, see Project Management.

VC FILES TAB

The VC Files Tab displays open version control files. This tab displays files listed in the *.xml file
for the version control files. The tab displays a checkbox icon for files that are checked-out.

For more information, see Version Control.

RapPID SQL WINDOWS

The Rapid SQL interface includes several windows to help you develop your program. The
windows include:

Topics

® Describe Window

OQutput Window

Browsers

Workspaces

Preview Dialog Boxes

DESCRIBE WINDOW

Rapid SQL offers a floating Describe window for procedures, tables, views, and functions (Oracle
and IBM DB2 LUW for Open Systems only). In the Describe window, you can view columnar
information (for tables and views) or input parameter information (for procedures and functions).

Opening the Describe Window
Rapid SQL offers three ways to open the Describe window:

1 In an editor, right-click an object and then click Describe from Cursor.

2 On the Explorer Tab, select an object and then click Describe.
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3 On the Explorer Tab or in an editor, select an object and then press CTRL+D.

Using the Describe Window

In the Describe window:
1 Click the Name list and then click a name to view a list of types of objects in the database.

2 Click the Owner list and then click an owner to view a list of all owners of objects in the
database.

3 Click the Type list and then click a type to view columnar information (for tables and views) or
input parameter information (for functions and procedures).

OuTPUT WINDOW

Rapid SQL incorporates a separate window to capture all messages returned by the server and
to log entries about the progress of operations started by the application.

For more information, see Configuring the Output Window

CONFIGURING THE OUTPUT WINDOW
Rapid SQL lets you display, hide, or dock the Output Window anywhere in the application.

Displaying the Output Window
1 On the View menu, click Output.

OR
On the Main toolbar, click Output.

Rapid SQL displays the Output Window.

Hiding the Output Window
1 On the View menu, click Output.

OR

On the Main toolbar, click Output.

OR

Right-click the Output Window and then click Hide.

Rapid SQL hides the Output Window.

Docking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL docks the Output Window to the bottom of the application frame.
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Undocking the Output Window
Right-click the Output Window and then click Docking View.

Rapid SQL displays the Output Window as a floating window in the application.

MESSAGES IN THE OUTPUT WINDOW
The Output Window lets you save, print, copy, and clear server messages.

Saving Server Messages
1 Right-click the Output Window and then click Save.

Rapid SQL opens the Save As dialog box.
2 Enter the location and name of the file in the File Name box.

NOTE: Rapid SQL defaults the file extension to .msg.

3 To save the file, click OK.

Printing Server Messages
1 Right-click the Output Window and then click Print.

Rapid SQL opens the Print dialog box.

NOTE: Rapid SQL prompts you with information on the size of the print job before opening
the Print dialog box.

2 Configure your print job.
3 Click OKto print the file.

Copying Server Messages
1 Right-click the target Server Messages and then click Copy.

Rapid SQL copies the selected text to the Microsoft Windows Clipboard.

2 Paste the contents of the clipboard into target applications.

Clearing Server Messages
1 Right-click the Output Window and then click Clear.

Rapid SQL clears your Server Messages.
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Browsers are a flexible environment where you can examine, extract, and execute database
objects and their dependencies. Browsers provide the means to view objects types across
multiple database platforms and connections. You can simultaneously view and work with
objects from InterBase/Firebird, Oracle, Microsoft SQL Server, Sybase Adaptive Server, and IBM
DB2 LUW for Open Systems.

The benefit of using Browsers is the ability to see detailed information about specific object
types. You can also print, search, copy, and sort the contents of a Browser window.

Topics

Browser Toolbar

Opening Browsers

Browser Object Types

Extracting DDL from Browsers

Displaying Dependencies from Browsers

Refreshing Browsers

BROWSER TOOLBAR
You can place the floating Browser toolbar anywhere on the Rapid SQL workspace.

For more information, see Browsers.

OPENING BROWSERS
Browsers let you view all types of database objects, including the SQL procedures used to build
them. Browsers let you:

e Copy database objects
* Modify database objects
¢ Test database objects

The ability to browse dependencies is especially useful, particularly when modifying SQL code in
procedures and triggers. For example, in a situation where a trigger enforces a rule that does
not let you update a particular box, you can use the Browser to do the following:

® Browse the triggers to find the offending trigger.
e Extract the DDL for that trigger into one window.

* In another window, drop the offending trigger, make your update to the box, then execute
the corrected trigger DDL to replace the trigger in the database.
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Opening a Browser Window

Rapid SQL offers two ways to open a Browser:

1 On the Browse menu, click the target object type.

OR

In the workspace, right-click, click Browser, then click the target object.

Rapid SQL opens a Browser.

For more information, see Browsers.

BROWSER OBJECT TYPES
Rapid SQL's Browsers read the appropriate object types for specific databases. A select
statement is issued against the appropriate systems table based on the requested object to
bring back a listing of the objects in the database. The table below contains a list of the
Browsers available for each database platform:

Constraints

Object Type | DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase
Aliases

Blob Filters

Check

Clusters

Databases

Database
Links

R N et

Defaults

Directories

Domains

Encrypted
Keys

Event
Monitors
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Object Type | DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase

Exceptions

v

Extended

Procedures ‘/ (‘

External
Functions f

Foreign Keys

Functions

Generators

Groups

Indexes

Libraries

Packages

Plans

PL/SQL Code
Profiling

Primary Keys

Procedures

Profiles

Roles

.

.

.

.
WON O N NN

*

Rules

Rollback
Segments ‘{‘
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Object Type | DB2 LUW DB2 z/OS InterBase/Firebird SQL Server Oracle Sybase

Segments

v

Sequences

Shadows

Snapshots

Snapshot
Logs

Materialized
Views

Materialized
View Logs

Synonyms

Tables
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WORKING WITH BROWSERS
Browsers offer a versatile method of browsing and managing the contents of your databases. To
help you maintain and organize your databases, you can:

® Print the contents of a Browser
e Search the contents of a Browser
¢ Copy the contents of a Browser

® Sort the contents of a Browser

Printing Browsers

1 Open a Browser for the desired object type.
2 On the File menu, click Print to open the Print dialog box.

3 Inthe Name box, click the list, which contains a list of local and network printers that you can
access (if you do not see any listed, then your computer is not configured for any printers).

4 Click the target printer.
5 In the Print Range box, click the appropriate option button to indicate print range.

6 Inthe Number of copies text box of the Copies box, click the Up or Down arrow or enter the
number of copies.

7 Click OK.

Rapid SQL prints the selection.

Searching Browsers

1 Open a Browser for the desired object type.

2 On the Edit menu, click Find.

Rapid SQL opens the Find box.

In the Find What text box, enter the search string.

To make the search case sensitive, select the Match Case check box.

To specify the direction to search, in the Direction box, click the Up or Down option button.

Click Find Next.

o~ o B~ w

Rapid SQL finds the next occurrence of your search string.

Copying Browsers

1 Open a Browser for the desired object type.

2 Select the objects to copy.

RAPID SQL XE 2/8.0.1 USER GUIDE 41



APPLICATION BASICS

3 On the Edit menu, click Copy.

4 Place the pointer at the position where you want to paste the objects, and then on the Edit
menu, click Paste.

Sorting Browsers

1 Open or Create a Browser for the desired object type.

2 Double-click the column header for the column of data to sort and Rapid SQL lists the
contents of the column in ascending order.

3 Double-click the column header again and Rapid SQL lists the contents of the column in
descending order.

For more information, see Browsers.

EXTRACTING DDL FROM BROWSERS

For each database type, Rapid SQL provides an appropriate Browser. The Browsers are mutually
exclusive object windows, showing only objects of a given type. If you connect to multiple
datasources, you have access to a number of objects that are not available based on the
database platform. Rapid SQL includes intelligence to determine the valid object types in the
underlying datasource.

Using the Main Menu
1 On the Browse menu, click the target object type.

Rapid SQL opens the appropriate Browser:

2 Inthe Browser, double-click the target object type to extract the object type DDL into a DDL
Editor.

Using the Browser Toolbar

1 On the Browser toolbar, click Tables.

Rapid SQL opens the Table Browser:
2 Click the scroll bar arrow to locate the target table.
3 Double-click the target table.

Rapid SQL extracts the schema DDL into a DDL Editor.
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Using the Shortcut Menu

1 Right-click an open area of the workspace, click Browsers, and then click the target object
type.

2 In the Browser, double-click the target object type.
Rapid SQL extracts the schema DDL into a DDL Editor.

For more information, see Browsers.

DISPLAYING DEPENDENCIES FROM BROWSERS

You can display object dependencies for an object from its corresponding object Browser. Rapid
SQL displays the dependencies in a separate result set window.

Displaying Dependencies
Rapid SQL offers three ways to display dependencies from Browsers:
1 Open a Browser for an object type.

2 Inthe Browser, click the target object.

3 On the Object menu, click Dependencies.

OR

On the Browser toolbar, click Dependencies.

OR

Right-click the target object and then click Dependencies.
Rapid SQL displays dependencies in a separate window.

For more information, see Browsers.

REFRESHING BROWSERS
Rapid SQL lets you refresh and display the results of a Browser operation.

Refreshing the Browser
1 On the Object menu, click Refresh.

OR
On the Browser toolbar, click Refresh.
OR

Right-click the Browser workspace and then click Refresh.
Rapid SQL refreshes the results of the browser operation.

For more information, see Browsers.
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WORKSPACES

Workspaces are a convenient way to maximize your desktop. You can use workspaces to multiply
the amount of scripting, script execution, and development resources you have available at any
one time. Rapid SQL lets you open and use several workspaces at one time. Using more than
one workspace lets you:

e Execute long running scripts in one workspace while working in other workspaces.

e Develop strategies for working on scripts and result sets in one workspace while other
scripts reside in one or more of the other workspaces.

Toggling Between Workspaces

Rapid SQL offers two ways to toggle between workspaces:
1 On the Main toolbar, click Workspace.

OR

Right-click the current workspace and then click the target workspace.
Rapid SQL brings the target workspace forward.
For more information, see:

Managing Workspaces

MANAGING WORKSPACES

Rapid SQL provides you with three default workspaces. You manage the workspaces in the
Workspace dialog box. Using the Workspace dialog box you can:

e Differentiate between workspaces by changing the background color or wallpaper.
¢ Toggle among workspaces.

e Create, delete, rename, and specify the order of workspaces.

Managing Workspaces

The Workspace dialog box lets you manage all open windows in your workspace.

1 On the Windows menu, click Windows.

Rapid SQL displays the Workspace dialog box. Any open windows in the current workspace
display in the list.

The table below describes the options and functionality on the Workspace dialog box:

Option Description

Activate Sets the focus onto the window you have selected in the list
and closes the Workspace dialog box.

OK Closes the Workspace dialog box and accepts any changes you
have made to the windows in the current workspace.
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Option Description

Save Saves the contents of the window you have selected in the list.
You are prompted to provide a name and location for the file
you are saving if you have not done so already.

Close Window Closes the window you have selected from the list. If you have
not saved the contents of the window, you are prompted with a
save file alert.

Help Initiates and displays this Help topic in the Rapid SQL Help.

SET SORT COLUMNS DIALOG BOX

The Set Sort Columns dialog box lets you sort multiple columns, and sort column identification,
in the Right Pane of the application.

For more information, see Completing the Set Columns Dialog Box.

COMPLETING THE SET COLUMNS DIALOG BOx
To complete the Set Columns dialog box, do the following:

1 In the right pane of the application, right-click a column heading and select Sort Multiple

Columns.

Rapid SQL opens the Set Sort Columns dialog box.

2 In Column Name select the column(s) to use to sort the information in the right pane of the

application.

3 Click the right arrow to move the column(s) to the Column Name box.

4 Click the up and down arrows to change the order of the sort columns.

For more information, see Set Sort Column Dialog Box.

PREVIEW DIALOG BOXES

Before executing any code, Rapid SQL offers Preview dialog boxes to let you confirm actions
before execution. In the Preview dialog boxes, you can:

Preview the code to execute.

View the SQL of the code on your database.

* Create a report detailing the affect of executing code on your database.

Schedule execution of the code.

Save the code to execute.

e Open your e-mail program with the code to execute as an attachment.

Print the code to execute.
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MENUS

Rapid SQL offers two context-sensitive menus to let you access all the application’s features. The
Main Menu is always on the top of the application window. The shortcut menu is accessible from
almost anywhere in the application. Right-click to view the available shortcut menu. Rapid SQL
lets you customize the Tools menu to help you tailor the application to your needs.

Topics

® Main Menu

Shortcut menus

Customizing General User Interface Appearance

MAIN MENU

Rapid SQL's features can all be accessed from the Main Menu by clicking the menu name and
selecting from the submenu. The menus are context sensitive and change based on the tasks
you want to perform. The table below describes the Rapid SQL menus:

Menu Item Description

File Create, open, close, print, send, and save script files and result
sets. Set application options and defaults.

Datasource Create, modify, select, connect to, and disconnect from
datasources. Access the database search facility.

Project Available only when a project is open. Configure project
management, build projects, and use version control functions.

Browse Browse any object type a datasource connection.

Lodfile Activate/deactivate, open, set options, and flush the Rapid SQL

application log.

View Arrange the Rapid SQL environment. Display or hide the
Database Explorer, toolbars, Output Window, Describe window,
activate full-screen mode.

Tools Choose any of Rapid SQL's tools, such as Database Search and
the Visual Diff Utility. Customize and add tools of your own.

Bookmarks Access and manage bookmarks.

Help Access HTML Help.

Query Available only when an Editor is open. Execute and set options
for your SQL scripts.

Object Available only when a browser is open. Execute, view

dependencies, extract, and refresh objects in a database.

Edit Available only when an Editor is open. Edit and manipulate the
text in your scripts.

Format Available only when a Result Window is active. Format the
contents of result sets.

Window Cascade and tile open windows. Toggle among open windows.
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For more information, see Menus.

EXPLORER BOOKMARKS
The Bookmarks menu lets you access and manage explorer bookmarks. Explorer bookmarks let
you quickly access nodes in the Database Explorer.

Creating Explorer Bookmarks
1 On the Database Explorer, right-click the target node, and then select Add Bookmark.

Rapid SQL opens the Add Friendly Bookmark Name dialog box.
2 Type the explorer bookmark name.
3 Click OK.

Rapid SQL displays the explorer bookmark under the Bookmarks menu. Explorer
bookmarks are organized by platform.

Editing Explorer Bookmarks
1 On the Main Menu, select Bookmarks.

2 Select Bookmark Manager.
Rapid SQL opens Bookmark Manager.

3 To rename the explorer bookmark, select the target explorer bookmark, and then click
Rename.

Rapid SQL opens the Edit Bookmark Name dialog box.
4 Type the new explorer bookmark name.
5 Click OK.
6 To delete an explorer bookmark, select the target explorer bookmark, and then click Delete.

TIP:  To add explorer bookmarks without using the Add Friendly Bookmark Name dialog
box, select Do not show ‘Add Friendly Bookmark Name' dialog option.

SHORTCUT MENUS

Rapid SQL incorporates context-sensitive menus to give you another way to access object
functionality. These menus mirror the functionality that you can access from application toolbars
or the main menu.

Opening Shortcut Menus
1 Right-click anywhere on the Rapid SQL desktop to open the appropriate shortcut menu.

For more information, see Menus.
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TOOLBARS

Rapid SQL toolbars change to reflect the element of the application you are using. The toolbars
contain icons that are the fastest way to access commonly used features of Rapid SQL. You can
move the toolbars to horizontal or vertical positions anywhere on the screen, and you can toggle
them off and on by using the shortcut menu when the pointer is positioned over one of Rapid
SQL's toolbars. For more information, see the following topics:

e Available Toolbars

¢ Using Toolbar Viewing Options

* Moving Toolbars

NOTE: For related information, see Customizing General User Interface Appearance.

AVAILABLE TOOLBARS
The following list represents Rapid SQL's toolbars:

Datasource Toolbar

33 g DAVE_DW (DAVE_DW 09.01,0000] - - L

Registration Toolbar
e
Main Toolbar

R ba s s g BEEES = B

Windows Toolbar

windows ]
BRI ET

Tools Toolbar
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Project Toolbar
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USING TOOLBAR VIEWING OPTIONS

Rapid SQL offers standard Windows toolbar options such as docking, floating, and positioning
toolbars.The only application-specific viewing option is the hiding or display of the individual
toolbars.

To hide or display a toolbar

1 On the View menu, select Toolbars and then select the specific toolbar you want to display
or hide.

For information on the toolbars available, see Available Toolbars.

MOVING TOOLBARS
1 Click the pointer at the right edge of any toolbar.

2 Drag the toolbar to the new position.

For more information, see Toolbars.

CUSTOMIZING GENERAL USER INTERFACE APPEARANCE

Rapid SQL lets you choose from a set of general visual application styles, dictate hiding or
display of particular items, and select preferences for specific user interface elements.
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To customize the general look and feel of Rapid SQL
1 On the View menu, select Toolbars and then select Customize. The Customize dialog
opens.

2 Use the following table as a guide to understanding and setting options on tabs of the
Customize dialog:

Tab Settings and tasks

Toolbars Select the toolbars you want to display in the application. For information on the toolbars
available, see Available Toolbars.

Application Visual | Select a visual style such as Microsoft Windows XP or one of the .NET options from the

Style dropdown. Depending on your selection, the following options may or may not be enabled:
Use default Windows XP colors, OneNote style tabs, Docking Tab Colors, Allow MDI Tab
Swapping, Enable Smart Docking, Enable Tab Menu, and 3D Rounded Docking Tabs.

Menu animations Lets you specify a menu animation style of UNFOLD, SLIDE, or
FADE.
Menu Shadows Displays shadowed 3D effects.
Tools Lets you define external applications to run from the Tools menu of Rapid SQL: the text

displayed on the Tools menu command (Menu contents), the path and file name of the
executable (Command), optional Arguments, and an optional Initial Directory.

For detailed information on providing arguements, see Specifying an Argument for a Tools
Menu Command.

Keyboard Category Select a general category for a hot key for the command.
Commands Select a hot key command, based on the general category.
Description Displays the command description.
Set Accelerator for Select application area where you want new hot key to be active.
Current Keys Displays current hot key.
Press New Shortcut Press keyboard key or an unassigned F key.
Key
Options Show ScreenTips on Select to display a ScreenTip when you hover your mouse over a
toolbars button. For example, when you hover your mouse over the New
button, Rapid SQL displays the ScreenTip “New.”
Show shortcut keys in | Select to display a shortcut key in the ScreenTip when you hover
ScreenTips your mouse over a button. For example, when you hover your
mouse over the New button, Rapid SQL displays the ScreenTip
“New (CTRL+N).”

3 Click Apply at any time to implement any changes you have made and when finished, click
Close.

SPECIFYING AN ARGUMENT FOR A TOOLS MENU COMMAND

You can specify an argument to be passed to a program for newly added commands by
choosing one of Rapid SQL's predefined arguments or entering a command-line argument.
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The table below provides scenarios of how to use command-line arguments:

Command

Argument

Description

NOTEPAD.EXE

$$FilePath$$

Starts Microsoft Notepad displaying
the contents of the $$FilePath$$
argument.

ISQL.EXE

-U$$CurUserID$$ -P$$CurPwd$$
-S$$CurConString$$ -
i$$FilePath$$

Starts ISQL, automatically connects
to the current datasource using the
current user name and password,
and executes the contents of

$$FilePath$s.

SQLPLUS.EXE

$$CurUserlD$$/
$$CurPwd$$@$$CurConString$$
@$$FilePath$$

Starts SQL*Plus, connects to the
current datasource using the current
user name and password, and
executes the contents of

$$FilePath$$.

The table below provides scenarios of how to use Rapid SQL's predefined arguments:

Argument Description

$$FilePath$$ The complete filename of the current source (defined as
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if
a non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if
the non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source
window is active.

$$CurlLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserID$$ The name of the current datasource user.

$$CurPwd$$ The current datasource password.

$$CurConString$$ The current connection string or server name.
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PREDEFINED ARGUMENTS
Rapid SQL provides a number of predefined arguments that you can pass to programs that you
have added to the Tools menu. The table below lists the available predefined arguments:

Argument Description

$$FilePath$$ The complete filename of the current source (defined as
drive+path+filename); blank if a non-source window is active.

$$FileDir$$ The directory of the current source (defined as drive+path); blank if
a non-source window is active.

$$FileName$$ The filename of the current source (defined as filename); blank if
the non-source window is active.

$$FileExt$$ The filename extension of the current source; blank if a non-source
window is active.

$$CurLine$$ The current cursor line position within the active window.

$$CurCol$$ The current cursor column position within the active window.

$$CurText$$ The current text (the word under the current cursor position, or the
currently selected text, if there is one).

$$CurDir$$ The current working directory (defined as drive+path).

$$CurDatasource$$ The name of the current datasource as defined in Rapid SQL.

$$CurUserlD$$ The name of the current datasource user.

$$CurPwd$$ The current datasource password.

$$CurConString$$ The current connection string or server name.

NOTE: Arguments are case-sensitive.

KEYBOARD SHORTCUTS

Rapid SQL provides a number of keyboard shortcuts to help you expedite your tasks. The table
below lists the taxes and related shortcuts:

General Editing Keyboard Command
Delete one character to the left BACKSPACE

Delete one character to the right DELETE

Cut selected text to the Clipboard CTRL+X

Undo the last action CTRL+Z

Redo the last undo operation CTRL+Y

Copy text CTRL+C

Paste the Clipboard contents CTRL+V
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To Extend a Selection

Keyboard Command

One character to the right

SHIFT+RIGHT ARROW

One character to the left

SHIFT+LEFT ARROW

To the end of a word

CTRL+SHIFT+RIGHT ARROW

To the beginning of a word

CTRL+SHIFT+LEFT ARROW

To the end of a line

SHIFT+END

To the beginning of a line

SHIFT+HOME

One line down

SHIFT+DOWN ARROW

One screen up

SHIFT+PAGE UP

To the beginning of a document

CTRL+SHIFT+HOME

To the end of a document

CTRL+SHIFT+END

To include the entire document

CTRL+A

To Move the Insertion Point

Keyboard Command

One character to the left LEFT ARROW

One character to the right RIGHT ARROW

One word to the left CTRL+LEFT ARROW
One word to the right CTRL+RIGHT ARROW
One line up UP ARROW

One line down DOWN ARROW

To the end of a line END

To the beginning of a line HOME

One screen up (scrolling) PAGE UP

One screen down (scrolling) PAGE DOWN

To the end of a document CTRL+END

To the beginning of a document CTRL+HOME

Bookmarks Keyboard Command
Toggle bookmark on/off CTRL+F2

Go to next bookmark F2

Go to previous bookmark SHIFT+F2
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Splitter Windows

Keyboard Command

Go to next pane

F6

Go to previous pane

SHIFT+F6

Debugger Operations Keyboard Command
Start Debugging CTRL+F5

Stop Debugging SHIFT+F5

Step Over F10

Step Into F11

Run to Cursor CTRL+F10

Step Out SHIFT+F11

Describe from Cursor CTRL+D

Insert or Remove Breakpoint F9

Toggle (Enable or Disable) Breakpoint CTRL+F9

Edit Breakpoint ALT+F9

Go F5

Restart CTRL+SHIFT+F5
Debugger Windows Keyboard Command

Open or Close Watch Window

ALT+3

Open or Close Variables Window ALT+4
Open or Close Call Stack Window ALT+5
Open or Close Dependency Tree Window | ALT+6

ISQL Window.

Other Windows Keyboard Command
Go to the Result Tab CTRL+ALT+R

Go to the Query Tab CTRL+ALT+Q

Open the Describe window (for highlighted | CTRL+D

object)

Toggle between Workspaces CTRL+W

Toggle between Datasource Explorer and | CTRL+ALT+E
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FULL SCREEN MODE

Rapid SQL has full screen mode capabilities so you can conceal the application framework and

use the entire monitor area. Full screen mode hides any other applications running on the
computer and uses every available pixel for the application. Main menu functionality is
accessible through keyboard commands when you use full screen mode.

Activating Full Screen Mode
Rapid SQL offers two ways to activate full screen mode:

1 On the View menu, click Full Screen.

OR
On the Main toolbar, click Full Screen.

Rapid SQL expands the application to fit the entire monitor area.

NOTE: The Full Screen mode icon is a stand-alone floating toolbar.

Dismissing Full Screen Mode
1 Click Full Screen to expand the application to fit the entire monitor area.

TIP:  Ifyou closed the Full Screen mode toolbar, right-click the top of the Rapid SQL desktop
to bring the toolbar back.

2 Click Full Screen to restore the application to the default size.
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TUTORIAL EXERCISES

The exercises that follow walk you through the Rapid SQL's major functional areas. After
completing these exercises, you will have the foundation you need to explore the many features
and benefits of Rapid SQL. You'll have learned how to competently manage the major database
administration and development tools provided.

This guide is divided into a set of sessions:

e Session 1: Getting Started

e Session 2: Productivity Enhancers

e Session 3: Scripting
e Session 4: Working with Code Workbench

e Session 5: Building a Database Project

e Session 6: Visual Query Builder

e Session 7: Live Data Editor

e Session 8: Code Analyst

e Session 9: SOL Debugging and Profiling

You can use this basic tutorial as a roadmap of product highlights, but also to help you find your
own path to explore Rapid SQL.

Once you've started, you can select Help Topics from the Help menu to find many additional
resources that complement and build on many of the activities shown in this tutorial.

SESSION 1: GETTING STARTED

Before anything else, you must perform the following tasks:

e Starting Rapid SOL

e Reqistering Cross-Platform Datasources

STARTING RAPID SQL
How you start Rapid SQL depends on the type of application you are evaluating:

* InstantOn version - start the application by double-clicking the file you downloaded.

e Fully-installed version - The Start menu sequence for Rapid SQL is always in the form
Programs > Embarcadero Rapid SQL version identifier > Embarcadero Rapid SQL
version identifier, where version identifier reflects the version you are running.
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To get started
1 Run Rapid SQL.

The first time Rapid SQL starts, a dialog opens, prompting you to set up datasources. In
addition to letting you manually set up individual datasources, a number of more
automated methods are available. If you have installed and used other Embarcadero tools,
Rapid SQL can find any active datasources being used by those tools. In addition, Rapid
SQL provides a Discover Datasources feature that automatically searches the DBMS
configuration files on your system for datasources that are not currently registered. Since
other Embarcadero tools let you export datasource definitions to file, you also have the
option of importing these definitions.

2 For the purpose of this tutorial, click Cancel. You will be registering a datasource manually.

The main Rapid SQL window opens.
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REGISTERING CROSS-PLATFORM DATASOURCES

For now, you will register a datasource manually.

On the Datasource menu, select Register Datasource. A Datasource Registration Wizard
opens.

-

Datasource Registration

Information |E=-31 =
Select the database tym L2

Datshase Tvpe | @t
Connection Information SR

: Y Microzaft SAL Server
Security Parameters
Dakasource Properties 'r::' hpSLIL
Dratasource Eroup i Oracle

' Sybaze Adaptive Server

" InterB aze/Firebird
() ODBC

| Hest » | | Firuzh | | Cancel | | Help

Choose Microsoft SQL Server as the DBMS type and then click Next.

Specify the Host name of an SQL Server datasource on your network, override the
Datasource Name with SAMPLE_DATASOURCE and then click Next.

Provide valid credentials in the User ID and Password boxes, and then select the Auto-
Connect? checkbox to eliminate having to provide credentials each time you connect to this
datasource.

In the left-hand pane, select Datasource Group, select the MS SQL Server folder, and then
click Finish.

NOTE: The Datasource Group panel also lets you assign a category to a datasource. This
provides a means to visually distinguish between different server purposes,
development vs. production, for example, in your enterprise. Categorization is a
customizable feature.

6 Select Yes when prompted to connect to the new datasource.

Rapid SQL offers the same easy-to-use Datasource Registration Wizard for all supported DBMS
platform connections. The connection information only needs to be set up one time for each
platform and can be saved locally or in a common datasource catalog for use by other
Embarcadero products.
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By default, Rapid SQL stores datasource definitions in the Windows Registry. There is also a
local, file-based option. Embarcadero products supporting these methods can share datasource

catalogs on the same machine.

There is also a network-shared storage option.

Rapid SQL also offers the ability to import and export datasource definitions. This lets you share

definitions among users and across datasource storage methods.

SESSION 2: PRODUCTIVITY ENHANCERS

This session focuses on some commonly used time-saving features:

60

The Database Explorer Tree

Creating an Object Using the Object Creation Wizard

Working With an Existing Object Using the Object Editor

Object Documentation and Reporting

Working With Code, Files and Data

Setting Environment Options
Favorites Tab

Working with Scripts and Files

Viewing Data
Retaining Datasource Explorer View Settings

Datasource Explorer Bookmarks

Setting Keyboard Shortcuts and Hotkeys

Referencing Most Recently Used Datasources

RAPID SQL XE 2/8.0.1 USER GUIDE



TUTORIAL EXERCISES

THE DATABASE EXPLORER TREE

Rapid SQL makes it easy and intuitive to navigate between datasources and to drill-down into
atomic database objects within the Database Explorer Tree. The Database Explorer Tree displays

all registered datasources and serves as the entry-point for much of Rapid SQL's advanced
functionality.

1 Click on the Explorer title bar and select Organize By Object Type.

Organizer o x

* Explorer - By Ohject Type | &
= Managed Datasources |
#{3 DB2 Servers

EiEs MS SOL Servers

2 Select and expand the SAMPLE_DATASOURCE > Databases > pubs node to display the
database object sub-nodes.

=] pubs
[+ 4—1—* Check Constraints
[+ ﬁ-u Database Triggers
i+ Defaults
[+-345 Foreign Keys
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CREATING AN OBJECT USING THE OBJECT CREATION WIZARD

From within the Database Explorer Tree you can create any databa